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Service safety summary
Only qualified personnel should perform service procedures. Read this Service safety summary and the General safety summary in the
service manual for your product before performing any service procedures.

Do not service alone. Do not perform internal service or adjustments of this product unless another person capable of rendering first aid
and resuscitation is present.

Disconnect power. To avoid electric shock, switch off the instrument power, then disconnect the power cord from the mains power.

Use care when servicing with power on. Dangerous voltages or currents may exist in this product. Disconnect power, remove battery (if
applicable), and disconnect test leads before removing protective panels, soldering, or replacing components.

To avoid electric shock, do not touch exposed connections.

Service safety summary
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Kit description
Supported products
This document supports installing an optional solid state disk drive (SSD) on Tektronix 5/6 Series MSO instruments. Refer to the following
table for a list of all the supported product models. This kit is a collection of parts that, once installed, configure the instrument with a SSD
with the Microsoft Windows 10 operating system or closed embedded operating system.

You can remove a supported SSD from one instrument and install it on another.

Item Description
5 Series MSO instruments All MSO54, MSO56, MSO58 models that do not have option 5-SEC (enhanced security) installed at

the factory.

The 5 Series MSO Low Profile (MSO58LP) does not support option SUP5-WIN.

5 Series B MSO instruments All MSO54B, MSO56B, MSO58B models.
6 Series MSO instruments All MSO64 models that do not have option 6-SEC (enhanced security) installed at the factory.
6 Series B MSO instruments All MSO64B, MSO66B, MSO68B models.

Minimum tool and equipment list
No tools are required to install the SSD.

Kit parts list
The following table lists the parts for the kit.

Quantity Part number Description
1 each SUP5-WIN The SSD installed in bracket. The SUPx-WIN SSD comes with Microsoft

Windows 10 installed. The SUPx-LNX is an expansion SSD with an
embedded OS.

SUP5B-WIN, SUP5B-LNX
SUP6-WIN
SUP6B-WIN, SUP6B-LNX

1 each 071-3542-xx Upgrade Kit Installation Instructions (this document)

Kit description
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Installation instructions
Install the SSD
The optional SSD assembly installs in the bottom of the instrument. To remove a previously installed SSD, reverse these steps. Contact
your nearest Tektronix, Inc., Service Center or Tektronix Factory Service if you need any installation assistance.

Prerequisite: Wear an anti-static wrist strap connected to the instrument chassis while installing this drive.

1. Remove all cables from the front and rear of the instrument, including the power cable.
2. Position the instrument on its back, with the bottom facing you.
3. Remove the SSD cover from the bottom of the oscilloscope as shown.

4. Slide the connector end of the SSD into the drive connector bracket. Push firmly to seat the drive in the connector.

5. Push down on and tighten the thumb screw to attach the SSD to the chassis.
6. Reinstall the SSD cover on the bottom of the instrument.

Installation instructions
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7. Restore the instrument to its normal operating position.

Note: After installing a Windows SSD, go to the Powering on Windows for the first time on page 7 and Activating
Windows on page 7 procedures. These procedures do not apply when installing the SUPx-LNX options.

Powering on Windows for the first time
The instrument goes through a series of configuration bootups that require manual intervention when first powering up a new (never-
installed) Windows drive in an instrument. Once the drive is configured, the instrument boots into Windows and starts the oscilloscope
application from then on.

1. Power on the instrument. The oscilloscope powers up to initialize some settings, then shuts down.
2. Power on the instrument again. The instrument powers up into the application startup screen, then displays a message at the bottom of

the screen:

Updating System Files... This will take a few minutes.

The oscilloscope will shut down when the update is complete.

After a few minutes, the instrument powers down.
3. Power on the instrument again. The instrument boots up into Windows and starts the oscilloscope application.

The instrument attempts to activate the Windows license as part of the initial power-on process (See Activating Windows on page 7).

Activating Windows
The Windows operating system shipped from Tektronix is in a "deferred activation" state. The first time you power on an instrument with a
newly installed Windows drive, the operating system may attempt to activate itself, depending on whether the instrument is connected to a
network.

• The instrument is connected to a network with access to the Microsoft web site:

• The Windows activation occurs silently in the background, and does not display any messages. No other action is required.
• See Verifying Windows activation on page 8 to check the activation status of the instrument.

• The instrument is connected to a network without access to the Microsoft web site:

• The instrument may attempt to activate and fail. You may see a screen message saying that Windows is not activated and the
Windows user settings may be disabled.

• See Verifying Windows activation on page 8 to check the activation status of the instrument.
• You can activate Windows by either connecting the instrument to a network with access to Microsoft or by contacting Microsoft to

obtain activation instructions:

• Go to https://support.microsoft.com/en-us and select Windows.
• Go to https://support.microsoft.com/en-us/contactus/ and follow the instructions to select your preferred contact method.

Note: Please contact Microsoft to resolve Windows activation issues.

• The instrument is not connected to any network:

• The instrument stays in the "deferred activation" state. No error message appears. Windows, and the oscilloscope application, can
operate indefinitely in the deferred activation state without error messages.

• See Verifying Windows activation on page 8 to check the activation status of the instrument.
• Once you connect the instrument to a network with access to Microsoft, Windows will activate automatically (no interaction

required).
• Moving an activated Windows SSD from one instrument to another:

Installation instructions
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• Windows should remain activated. To verify activation, see Verifying Windows activation on page 8. If Windows lost activation
when installed on the current instrument, follow the above instructions to re-activate.

Verifying Windows activation
To check that Windows is activated:

1. Tap Start on the Windows taskbar.
2. Scroll down and tap Settings.
3. Tap Update & Security.
4. Tap Activation (left side list) to display the activation status.

Windows update
Automatic Windows update is disabled by default.

Differences between Windows and base instrument user interfaces
The Windows-based oscilloscope application interface appearance and behavior is exactly the same as the base instruments, with some
exceptions:

• You can change the size of the Windows-based oscilloscope application, or minimize it, just like any other Windows application.
• The File Utilities choice in the File menu opens a standard Windows Explorer instance instead of the custom dialog found in the base

instrument.
• You can use the standard Windows network tools to mount and access network drives.
• You can use the standard Windows tools to create a login password to access the instrument, if required by your organization.
• You can use the Application menu to access installed applications.

Updating the Windows TekScope application software
The Windows TekScope application does not automatically update when newer versions are released. You will need to manually download
and install the newer software. The oscilloscope application cannot be running when installing the software.

To update the Windows version of the oscilloscope application software:

Instrument is connected to a network:

1. Display the Windows desktop and open a browser.
2. Go to www.tek.com/product-support.
3. Enter your model number in the Enter Product or Product Series Name: field and click Go.
4. Click the Software tab (left side of table).
5. Click the link in the description that pertains to your instrument model or series, and select the software that applies for Windows

instruments.
6. Check that the listed software is newer than your current installed software before downloading and installing.
7. Follow instructions to download the application file.
8. Click on the install instructions link to open the installation instructions.

Instrument is not connected to a network:

Follow the above instructions on a network-connected PC,

1. Open a browser on a network-connected PC or laptop.
2. Do steps 2 on page 8 through 7 on page 8 above.
3. Download the installation file to a USB memory device and insert the USB memory device in any USB Host port on the instrument.
4. Open the USB drive location.

Installation instructions
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5. Double-tap on the installation file to update the application software; follow any on-screen instructions.

Download and install the latest instrument firmware
Installing the latest firmware helps ensure that your instrument has the latest features and is taking the most accurate measurements.

Prerequisite: Save any important on-instrument files (waveforms, screen captures, setups, and so on) to a USB drive or network. The
installation process does not remove user-created files, but it is a good idea to back up important files before an update.

Determine the current version of firmware installed on the instrument (see Help > About).

Update instrument firmware from a USB drive
1. To download the instrument firmware and install onto a USB drive:

a. Open up a Web browser on a PC and go to www.tek.com/product-support
b. Enter the instrument model number in the search field and click Go.
c. Scroll down the screen and click the Software tab.
d. If the listed available firmware version (Windows or non-Windows) is newer than what is on your instrument, select and download

that file to your PC.
e. Follow the installation instructions that are on the web site or that came with the downloaded firmware to create the firmware install

file.
f. Copy the firmware install file to a USB flash drive.

2. To install firmware on embedded OS instruments :

a. Power on the instrument and wait for the instrument to fully boot up.
b. Insert the USB flash drive into any instrument USB Host port.
c. The instrument detects the update firmware and opens a dialog box. Follow the on-screen instructions to install the firmware.

Note: Do not power off the instrument or remove the USB flash drive until the instrument finishes installing the firmware. The
instrument displays a message when it is OK to power off. Remove the USB drive before powering on the instrument.

3. To install firmware on instruments with the Windows option:

a. Close the TekScope program before updating the firmware.
b. Insert the USB drive into any instrument USB Host port.
c. Open the Windows desktop File Explorer and navigate to and select the install file.
d. Run the firmware update file from the USB drive, or copy the firmware update file to the desktop and run the file from there.
e. Follow any on-screen instructions to install the firmware.
f. When the firmware install is finished, remove the USB drive and restart the instrument.

Note: Do not power off the instrument, or remove the USB flash drive if installing from the drive, until the instrument finishes
installing the firmware. The instrument displays a message when it is OK to power off.

4. To confirm that the firmware was updated:

a. Tap Help > About in the Menu bar.
b. Check that the firmware version number listed on the screen is the same version that you downloaded.

Installation instructions
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Restoring a Windows SSD
When you need to recover your Windows system image backup use the following process to restore your Windows drive.

About this task
The goal of this procedure is to use the AOMEI OneKey Recovery to restore the latest version of your Windows drive.

Before you begin
• A keyboard is attached to the instrument.
• No USB drives are plugged into the instrument.

Procedure
1. Power off the instrument completely.
2. Power the instrument on.
3. From the Choose an operating system menu, select the Enter into AOMEI OneKey Recovery option. This menu is only displayed

for 5 seconds.
4. Select the Yes button when the Do you need to restore your system prompt appears.
5. Select the Start Restore button to confirm which drive partitions will be overwritten.

AOMEI Restore begins.
6. When the restore completes select the Finish button.
7. Select the X is the upper right corner to close the AOMEI application.

The instrument powers off and automatically restarts.
8. Verify that the instrument restored successfully.

Installation instructions
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